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 The Q&A session started with a 

PowerPoint presentation by Terry 

MacLennan on Internet Safety. It 

specifically dealt with Rogue/Fake 

Antivirus alerts and how to avoid 

contaminating your computer with 

these horrible malware programs. As 

Terry put it, no matter how much 

protection you have on your computer, 

if you click on a link in the rogue 

antivirus dialogue box, or try to close it 

using the ―X‖ (which is usually the way 

to close something you don’t want) the 

rogue/fake antivirus will download it’s 

payload to the computer and in his 

words, ―it will own the computer.‖ The 

presentation was very well received 

and we gave Terry a round of applause. 

 Art Bendick fielded some 

questions in the remaining Q&A 

session.  There was the usual break for 

cookies, pop and coffee.   

Betty Beatty conducted the meeting in 

the absence of President Joe Fornero, 

who is on his way to Hawaii with his 

wife Margie. 

 The minutes of last month’s 

meeting were accepted as published. 

Myron presented a new corrected 

Treasurer’s report for last month. The 

discrepancy was not in the amount of 

money in the club’s treasury but in 

where the money was allocated. It is 

now corrected.  He then presented this 

month’s report and both were 

accepted as read. 

Betty then thanked Lois the 

cookie maker and Art for his 

contribution of pop and coffee, and 

Neil and Art for setting things up for the 

meeting.  

Joe had asked Betty to remind 

everyone that the changes in the by-
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laws had to be voted on. Betty took a 

show of hands vote and the changes 

were voted in. 

The members also voted on:  

the question of the adoption of the 

motion that the newsletter is to be 

delivered via email as a PDF (instead of 

by US postal service) unless you do not 

have an email address or if you think 

your Internet connection is too slow to 

receive it this way (if this is the case 

please let Joe know who you are).  Betty 

mentioned that members were emailed 

earlier in the week about this issue.  

The motion was voted on via a show of 

hands and adopted by a majority show 

of hands.  One member voted against it.   

After the vote Betty asked 

members to let Joe know if you want a 

hard copy of the Computer Connection 

newsletter. Otherwise it will be emailed 

to you as a PDF.   

Neil demonstrated a new 

mouse he purchased for the club (a 

super Staples deal) with a built-in 

magnifier.  Members liked it. 

Betty announced that the May 

program will be on Twitter, with a 

special drawing for an autographed 

copy of Twitter For Dummies, 2nd 

Edition. 

It was moved and seconded to 

adjourn the meeting and Neil then held 

the raffle drawings. 

Paul Roe then made his 

presentation on the Apple iPad and 

iPhone which was interesting and well 

received. 

 

Respectfully submitted by  

Angela V. Rester, secretary 
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The SCUG board meeting was 

held at the home of Betty Beatty 

on Tuesday April 12, 2011. Board 

members present were Myron 

Kliment, Betty Beatty, Art 

Bendick, Terry MacLennan and 

Kent McNeill.   

 

Myron gave us the Treasury 

Report numbers from April’s 

meeting.  It was noted that April’s 

raffle was very successful 

bringing in $44.00.  (Main prize 

was a 16 GB flash drive won by 

Ken Hughes.)  Myron reminded us 

that the club’s bottom line looks 

good because we have just taken 

in all of our member dues.  From 

here on out until the end of the 

year it will mostly be money going 

out for club expenses.  But still 

we are in good shape. 

 

The board reviewed and approved 

the thank-you letter to be sent to 

Paul Roe.  Board members 

expressed their enjoyment of 

Paul’s April presentation on the 

Apple iPad and iPhone. 

 

Betty showed the board the 

autographed copy of Twitter for 

Dummies, 2nd Edition 

(autographed by author Laura 

Fitton) that will be given away 

after her May program on Twitter. 

 

The club is considering ideas for 

future programs.  Terry is 

tentatively scheduled to do the 

June program on how to create a 

Microsoft PowerPoint  (continued 

on page 8)presentation.  July will 

be the club’s annual cookout/

picnic with Chef Joe Fornero 

doing the grilling.  If anyone has 

an idea for a program they could 

give please contact Joe or a 

board member. 

U S E R  H E L P I N G  U S E R  

 

The board members discussed the 

idea of the club getting a laptop 

with the Windows 7 operating 

system on it if we could find one at 

a  reasonable price.  Since 

Windows 7 is the operating system 

on computers being purchased at 

this time it seems like maybe the 

club should have a Windows 7 

computer to answer the Windows 

7 questions that our members 

might have, etc.  Our club com-

puter is running Windows XP which 

came out in 2001—but still many 

of our members are running XP.  

Anyone buying a new Windows 

computer will have Windows 7.  We 

want to stay relevant. This subject 

will require further discussion. 

The meeting was adjourned on a 

motion by Myron and seconded by 

Art. 

Respectfully submitted, in the 

absence of Secretary Angela V. 

Rester, by Betty Beatty 

B O A R D  M E E T I N G  M I N U T E S   

F O R  A P R I L  1 2 ,  2 0 1 1  

President Joe was on vacation and 

as Vice President it was my duty to 

run the April SCUG business 

meeting in his absence.  I had 

never run a club business meeting 

before and I had hoped there would 

be no new business so I could just 

coast through the meeting.  

President Joe had other ideas.  

Among other things he asked me to 

ask our members to consider and 

vote on the idea of sending SCUG’s 

monthly newsletter, The Computer 

Connection, via e-mail as a PDF.  

Wanting to give our members a 

heads-up, on April 5th, we sent the 

members an e-mail asking them to 

think about this idea and told 

everyone we would be voting on: 

―the question is on the adoption of 

the motion that the newsletter is to 

be delivered via e-mail as a PDF 

(instead of by US postal service) 

unless you do not have an e-mail 

address (one member does not) or 

if you think your Internet 

connection is too slow to receive it 

this way (if this is the case please 

let us know who you are).‖  

  

On Saturday, April 9th, after a brief 

and heated discussion, the 

members present voted via a show 

of hands.  A majority voted for 

receiving the newsletter via e-mail 

as a PDF (instead of by US postal 

service) and the motion was 

adopted.  (I also received e-mails 

from some of the members that 

were not present telling me they 

thought it was the way to go.) One 

member voted against the motion.   

  

As I said, I had never run a club 

business meeting before so I was in 

new territory.  I hope our members 

were okay with how the issue was 

presented and voted on.  I came 

SCUG Newsletter To Go 

Paperless! 

by Betty Beatty 

How to Open & Print the 

PDF Newsletter 

To open the PDF newsletter you will 

need Adobe Reader which most of you 

probably have on your computer.  If 

not, you can get it at:  http://

get.adobe.com/reader/.  It’s FREE.  To 

open your PDF file, just double click 

on it and it should automatically open 

in Adobe Reader.  To print it, File > 

Print.  To save a copy to your desk top 

(or somewhere else on your computer) 

choose File > Save a Copy and enter 

where you want it saved in the dialog 

box.  You will probably get a warning 

that you cannot change the document 

but only Save a Copy – that’s fine, 

click ok and a copy will be saved to 

your computer.  It’s quick and easy. 

http://get.adobe.com/reader/
http://get.adobe.com/reader/
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U S E R  H E L P I N G  U S E R  

M A Y  P R O G R A M  O N  T W I T T E R  

B Y  B E T T Y  B E A T T Y  

I will be doing the May program 

on Twitter. I am new to Twitter 

and I am still learning about it. It 

seems that everywhere we look 

we are being asked to follow 

someone on Twitter or to send a 

Tweet about this or that.  It’s all 

over the place these days.  Its 

users include heads of state, 

politicians, the major news 

services, celebrities including 

many professional athletes, and 

astronauts. 

  

Twitter displays a real time 

stream of news and information 

and it’s about what is happening 

right now.  Twitter is ranked as 

one of the 10 most visited 

websites worldwide.  More 

searches occur on Twitter than 

on Yahoo or Bing.   

  

Twitter just celebrated its 5th 

anniversary and is experiencing 

tremendous growth. Users are 

now sending 140 million Tweets, 

on average, per day.  In a given 

week, users send a billion 

Tweets. Tweets generally spike 

during a significant cultural event 

such as the Japanese 

earthquake.  Although exact 

numbers of current users have 

not been released, I have read 

estimates that there are probably 

over 200 million registered 

users. According to Michael 

Litman’s article: Social media by 

demographic: Who likes what? 

[infographic] http://bit.ly/

hlShOo, Twitter has the largest 

division of wealthy users with 

27% earning $75,000 or more.  

Also Twitter has the largest 

division of users with a 

secondary education.  37% have 

at least a bachelor’s degree. In 

light of all this, learning more 

about Twitter seems like a 

worthwhile endeavor or shall I 

say adventure. 

  

The May program will cover the 

basics of setting up an account, 

customizing your profile, finding 

people or businesses to follow, 

how to tweet and more. Let me 

mention that Twitter is 

constantly changing. So what 

you read today may not be the 

case tomorrow.  

  

Laura Fitton (known on Twitter 

as @pistachio) is one of the 

authors of Twitter for Dummies.  

She is very active on Twitter and 

also CEO/Founder of oneforty  -  

which helps businesses use 

social media, etc.  I contacted 

her and asked her if she would 

autograph and donate a copy of 

Twitter for Dummies – 2nd 

Edition to our club. She said yes 

– she even tweeted about it! So 

we will be giving away an 

autographed copy of this very 

informative book after the 

program.   

  

Hope to see you all at the May 

program on Twitter -  let’s 

explore the Twitterverse 

together! 

away thinking that that was the 

wildest SCUG meeting I had ever 

attended!  Oh my.  But I gave it my 

best shot.  Thanks for putting up with 

my inexperience.   

  

Sending the SCUG newsletter via e-

mail as a PDF will save printing and 

mailing costs.   We will probably still 

be printing some to hand out at our 

meetings and mailing a few to 

members without e-mail, etc.  This 

will still have to be worked out by our 

newsletter editor/President Joe.  

  

PDF newsletters make it easy and 

cost-efficient to use color graphics 

which could make the newsletter 

more visually appealing.  And if you 

are reading it online you can click 

most hyperlinks mentioned and go 

directly to the corresponding web 

site.  Of course you can print the 

newsletter if you want a hard copy.  

And we are a computer club, so 

getting our newsletter via computer 

seems appropriate. 

  

Remember:  ―Change is inevitable - 

except from a vending machine.‖  

~Robert C. Gallagher  

SCUG Newsletter To Go 

Paperless! (cont.) 

Do we have your correct             

e-mail address? 

 All member please check the 

Members Only side of the web site to 

make sure we have your correct       

e-mail address.  If we do not, please 

e-mail the correct e-mail address to 

Joe or Betty.  We want to make sure 

you get your newsletter.   

 

 You will need a user name 

and password to access the 

Members Only section.  E-mail Betty 

if you cannot remember yours or if 

you need to set one up. 

 

Thanks! 

http://bit.ly/hlShOo
http://bit.ly/hlShOo
http://oneforty.com/


Page 4 

existing driver or put a new 

one in that loads and then 

fails. The way to fix this is 

to do a system repair or a 

complete reformat and 

installation. I did not want 

to impose that cost on my 

customer, and she agreed 

(it’s not a primary com-

puter, and it’s rather old). 

So I left it that way. 

2.   All the system restore 

 points were unusable. Re

 fused to restore to any 

 point. 

3.   To run most anything, an 

official-looking popup 

would ask to confirm the 

logon user and give a box 

for an alternative user ac-

count that did not work. 

This is to make sure that 

everything you try is run 

under the current user ac-

count which has been 

modified to prevent cir-

cumventing the virus. 

What you want to run is 

Explorer.exe giving you 

your desktop, and every 

effort is made to prevent 

you from doing this. 

4.   Most – perhaps all – items 

in Control panel will not 

run. It gave a warning that 

the administrator account 

has restricted its use. I did 

manage to get into the 

power configuration, but it 

would not accept any 

change. The computer 

would go into sleep mode 

after about 20 minutes, 

keeping me from running a 

full system scan from any 

antivirus software unless I 

sat there and wiggled the 

mouse occasionally for 

four hours. 

5.   The Internet articles say 

U S E R  H E L P I N G  U S E R  

that even if you purchase 

the software to fix a bogus 

virus, ThinkPoint stays on 

the computer. The uninstall 

just errors out. 

6.   The Internet articles say 

that it installs other viruses, 

and I did find a half dozen 

other viruses, mostly 

downloaders. 

7.   It leaves about 20 copies of 

itself under various random 

names, and places items in 

the registry to run each of 

them. So removing the ac-

tive virus is just the begin-

ning. I also found a couple 

of viruses in the System 

Restore files. 

8.   It apparently makes 

changes to the current user 

account profile that look 

like group policy changes, 

even though this was Win-

dows XP Home, which does-

n’t have group policy capa-

bility. 

9.   Only after all the bad soft-

ware is cleared from the 

machine can you then get 

rid of the modified account 

by creating a new adminis-

trative account, copying all 

of the user files from the 

old to the new – except for 

the profile files, then delet-

ing the old account after 

locating the email files. 

 

Isn’t this scary? It is to me, and I 

(95%) fixed this one with a lot of 

work. The idea of having to fix my 

own machine after something like 

this gives me nightmares. 

 

What you can do to prevent this: A 

sizable number of virus infections 

now are rogue anti-virus’. There’s 

an understandable reason for this. 

It creates revenue. Old-fashioned 

I recently was asked to remove a 

virus from a friend/client’s note-

book. For all intents and pur-

poses, it rendered the computer 

completely in-operative. The virus 

was in a virus category of ―Rogue 

antivirus software.‖ There are 

many of them out there for the 

unwary to catch, and this one, 

called ―ThinkPoint,‖ even has the 

Windows flag on it to further fool 

you into thinking it is legitimate. 

The only option you can see is 

―Safe Startup,‖ and that takes 

you to a virus scanner and a way 

to purchase the product. If you 

close it out, it shows you a blank 

desktop, no icons, no menus. You 

can turn the machine off, that’s 

about it. Turn it back on, same 

situation. I did figure out a way to 

kill it through the Task Manager’s 

Run command, and then run the 

desktop. I also found some things 

written up on the Internet to do 

something similar, but no help in 

removing it. I did remove it using 

some very clever, obscure skills, 

several virus scanners, then find-

ing and removing twenty or so 

copies of it. But the computer 

really didn’t work well enough to 

use. What I found surprised me, 

and this is what the article is 

about and what you can do. 

 

Here’s a list of what I found. 

Some things are by deduction 

and may not be 100% accurate. 

But I am 100% certain that these 

problems existed. All of the things 

fit into a strategy that prevents 

you from fixing the computer. 

 

1.   The worst thing: The com-

puter will not boot into 

safe mode. It blue 

screens every time. I’m 

speculating that Think-

Point either corrupted an 

What a Nasty Virus Can Do To Your Computer 

B Y  M E R L E  N I C H O L S O N   
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U S E R  H E L P I N G  U S E R  

What a Nasty Virus Can Do To Your Computer (cont.) 

viruses are malicious, but have 

no revenue-producing strategy. 

In other words, it’s now about 

money. Most all viruses are sent 

to you via web pages, and most 

of those are porn sites, either 

designed that way or hacked 

from outside. Porn sites are vis-

ited so often, they are a very 

good candidate for this kind of 

thing. Also, presumably the porn 

site owners don’t have the skill 

to remove sophisticated hacks. 

But most any web site is vulner-

able. In any case, you must se-

lect something on the site – 

click on it – to give the browser a 

chance to violate security rules. 

 

The next common way to get a 

virus is with downloads. And that 

means just about any download 

or file transfer. So you have to 

get any and all files from reputa-

ble sites like iTunes or 

Downloads.com, Amazon etc., 

which have the resources to 

check their own content. 

 

But that leaves any and all file-

sharing sites absolutely and defi-

nitely off the list. So if you’re 

downloading songs for free, 

you’re in trouble. Any file-sharing 

site’s software must be unin-

stalled from your computer. 

 

And that also goes for any peer-

to-peer gaming sites, LimeWire, 

Kazaa, and any and all IM pro-

grams that allow peer-to-peer 

file exchanges. 

 

And while we’re at it, remove – 

uninstall – anything that says 

―Toolbar.‖ Right now. Want to 

know why toolbars are free? Be-

cause they’re a conduit for push-

ing advertising to you; and 

they’re easily exploited. Besides 

you don’t need them. They want 

you to believe you do, of course! 

But the browser itself and a couple 

of favorites will do anything a toolbar 

will do. 

 

An alternative is giving up gaming 

and IM and to start purchasing 

songs. So if you have kids who will 

just die without peer-to-peer gaming 

or IM and stealing songs, the answer 

is to live with it with some intelligent 

prevention. 

 

First, if at all possible, put the kids 

(and maybe grandpa) on a Windows 

7 machine. If you have some inter-

nal networking and file sharing, Win-

dows 7 Pro is better because it will 

back up to a network drive. But so 

will Acronis Home, 2010 or 2011, 

running under Win 7 Home Pre-

mium. 

 

Make sure you have a full system 

backup, and replace it monthly. Use 

Windows 7 Backup or Acronis. Be-

lieve me, restoring the entire system 

hard drive is way, way better than 

any alternative that I can think of. 

Look at what I had to do with Think-

Point. Want to try it? 

 

I guess it’s obvious, but a strong anti

-virus program running on your ma-

chine is essential. BUT – this is im-

portant – make sure you look at the 

scheduling part of it and make sure 

it will automatically download new 

definitions and also run a full system 

scan at a time of day that the ma-

chine will most likely be turned on. 

Same for Windows Updates. Make 

certain that all important updates 

are installed as soon as they are 

available. 

 

Password protect your main admin-

istrative account (this is the one that 

comes first with the computer) and 

bury the password paper in the back 

yard and leave the location with your 

attorney. Better yet, Win 7 allows 

you to create a flash drive that will 

unlock the computer. Hide it un-

der some rubber fake dog poop 

someplace. 

 

THEN: Create a non-

administrative account for your-

self – a regular non-privileged 

account, and a separate one – or 

one for each kid. A regular ac-

count cannot install software. But 

most importantly, SOFTWARE 

that is run under this account 

can’t install software. Ah HA! 

 

Then one more step. Set the 

screensavers to require a sign-in 

on wake-up, and ALWAYS log off 

when you leave the computer. 

That’s especially essential when 

leaving the administrative ac-

count. 

 

Skills: There are a few things that 

would be very helpful to learn. 

The big one is navigating the 

computer file system using Win-

dows Explorer. Find out how your 

files are organized, and more im-

portantly, how to change what 

files you can view. That’s in Win-

dows Explorer, Tools, Folder Op-

tions, View tab. Second Important 

Skill – learn to use the Add, Re-

move Programs. That’s 

―Programs and Features‖ in Vista 

and Win 7. When you find an in-

stalled program that you are not 

using (say, anything with the 

word Apple or toolbar), just 

uninstall it, and see how it goes. 

 
By Merle Nicholson, Secretary, Tampa 

PCUG, Florida 

November 2010 issue, Bits of Blue 

www.tpcug.org 

Merle (at) merlenicholson.com 

 

This article has been obtained from AP-

CUG with the author’s permission for 

publication by APCUG member groups; 

all other uses require the permission of 

the author. 

 

 

http://www.tpcug.org
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Oracle Corporation, a technology 

company best known for its flag-

ship commercial relational data-

base management software, is 

alienating the Open Source com-

munity it once embraced. In 

2008, Sun Microsystems ac-

quired MySQL AB, the company 

that developed and provided 

commercial support for the 

highly popular relational data-

base management system 

(RDBMS) software, MySQL, 

which is available in both Open 

Source and commercial license 

versions. MySQL is very popular 

(estimated at over eleven million 

installations) as backend soft-

ware used by web sites world-

wide, comprising part of the 

―LAMP‖ (Linux, Apache, MySQL, 

PERL/PHP/Python) software 

stack. 

 
Sun Microsystems is perhaps 

best known for the Java pro-

gramming language used to de-

velop software that can run on a 

wide variety of computer plat-

forms. The Open Source commu-

nity has been pushing for the 

release of control over the Java 

language specification to the 

community since at least 2004. 

In 2006, Sun released Java soft-

ware components under the 

GNU General Public License, but 

continued to release ―non-free‖ 

executable versions. 

 
Sun Microsystems also spon-

sored the OpenOffice.org com-

munity project, which developed 

and distributed a free, Open 

Source productivity suite compa-

rable to Microsoft Office and 

built upon code from the com-

mercial StarOffice product, previ-

ously acquired by Sun. 

 
In 2010, Oracle Corporation 

completed acquisition of Sun Micro-

systems, including MySQL, Java, and 

OpenOffice.org. During the acquisi-

tion, the MySQL community ex-

pressed concerns that Oracle would 

discontinue support for MySQL as it 

competed with Oracle's commercial 

RDBMS products. While this has not 

happened, Oracle recently doubled 

MySQL support service costs. 

 
In August 2010, Oracle sued Google 

over its implementation of Java in 

the Linux-based Android operating 

system, claiming infringement on 

seven patents. This move alienated 

the Java developer community. 

 
In September, a core group of over 

30 leading contributors to the 

OpenOffice.org project formed The 

Document Foundation with support 

from organizations including Red 

Hat, Novell, Google, Open Source 

Initiative, Canonical, and the Free 

Software Foundation. The Document 

Foundation's primary purpose is to 

support the community develop-

ment of LibreOffice, a productivity 

suite built upon the OpenOffice.org 

source code. This move was in re-

sponse to ongoing concerns about 

Oracle's governance and develop-

ment process for the OpenOffice.org 

project, including Oracle's reluc-

tance to accept patches to the soft-

ware. The Document Foundation's 

stated mission is to: 

 
“facilitate the evolution of the 

OpenOffice.org Community into a 

new open, independent, and meri-

tocratic organizational structure 

within the next few months. An inde-

pendent Foundation is a better 

match to the values of our contribu-

tors, users, and supporters, and will 

enable a more effective, efficient, 

transparent, and inclusive  
Community. We will protect past 

investments by building on the solid 

achievements of our first decade, 

encourage wide participation in 

the Community, and co-ordinate 

activity across the Community.” 

 
Oracle responded to the formation 

of The Document Foundation by 

insisting that members step down 

from their positions on the 

OpenOffice.org project as it cre-

ated a conflict of interest. As a 

result, it appears that community 

developers are migrating from 

OpenOffice.org to work on LibreOf-

fice. 

 
At this point, it appears that Ora-

cle has squandered whatever 

credibility it had with the Open 

Source (MySQL, Java, OpenOf-

fice.org) developer community, 

and the future of the original 

OpenOffice.org project is very 

questionable.  

 
However, expect to see rapid de-

velopment and improved software 

quality for LibreOffice under The 

Document Foundation. 
 

By Geof Goodrum,  President, Washington 

Area Computer User Group, VA 

December 2010 issue, The Cursor 

www.wacug.org 

president (at) wacug.org 

 

 
This article has been obtained from AP-

CUG with the author’s permission for pub-

lication by APCUG member groups; all 

other uses require the permission of the 

author. 
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Are you Secure? 
By Constance Brown  

Security is one of the most com-

mon concerns with today’s com-

puter based communications 

and transactions. How can I se-

cure my personal computer? 

Should I do banking online or is 

it safer to write checks and mail 

them? Is it safe to purchase 

products online? How much can 

people learn about me through 

online access? These questions 

are some of the most common I 

hear expressed by my students. 

Let’s look at some of these con-

cerns. 

 

First of all, we need to secure 

our personal computers. Most of 

us have high speed access in 

today’s world. If you leave your 

computer turned on and internet 

access turned on 24 hours a 

day, 7 days a week, you are 

more vulnerable than someone 

who has dial-up access and has 

to get offline in order to place 

phone calls. Dial-up is so slow 

that hackers don’t usually want 

to fool with it and users with that 

type of service are usually online 

only short periods of time. Those 

with high speed connections 

through DSL or cable can shut 

off their modems or turn off their 

computers. I have high speed 

access and VOIP phone service. 

So shutting off my modem is not 

an option for me. 

 

That is one reason I turn off my 

computer if I am not going to use 

it for several hours. I also prefer 

to place my documents on an 

external drive that I disconnect if 

I choose to leave the computer 

running while I go to town. 

 

Your personal computer needs 

to be protected with anti-virus 

and anti-spyware programs. It 

should also be protected with a 

firewall. One is included with 

Windows. A router provides an ad-

ditional level of protection. It plugs 

into the modem and your computer 

plugs into it. When some would-be 

hacker tries to get to your com-

puter, it finds the address of the 

router instead. Most routers come 

with programs to protect you. It is 

often necessary to update the 

router software to keep the protec-

tions as up-to-date as possible. 

 

If you are using a wireless router in 

order to send signal to other wire-

less devices, you will want to se-

cure your wireless network with 

strong encryption and a strong 

password. When you choose pass-

words for your network or for your 

bank accounts and online stores, 

be sure to choose a strong pass-

word with meaning to you but not 

to others. A word that is not in the 

dictionary is best. 

 

You will want to mix upper and 

lower case letters, include num-

bers, and a special letter if the site 

allows it. Let’s look at a couple of 

passwords.  Here are examples of 

two commonly chosen passwords 

that are dreadfully insecure: 

123456; abcdefg. Here is an ex-

ample of a strong password: 

E4g$jwQy. Normally passwords 

should be 8 characters or more. 

 

Is online banking secure? Many 

people pay their bills and monitor 

accounts regularly online. Banks 

require the use of a browser with 

specific standards of security. For 

example, if you are still using Inter-

net Explorer 6, your bank most 

likely will not allow you to set up 

online banking.  If anyone uses 

your computer other than yourself 

or your spouse, you will most likely 

NOT want to allow the site to re-

member your login information. 

Over the past two years, banks 

have added levels of security in-

cluding a picture id of your selec-

tion from choices they provide in 

addition to the login name and 

password. The only time I would 

not be comfortable doing banking 

or providing credit card informa-

tion for other types of transactions 

would be in places providing free 

public 

Wi-Fi. 

 

Is it safe to make purchases 

online? Buyer be informed! All ma-

jor retail companies have online 

stores. These have securities in 

place. After all, these corporations 

have much to lose if their names 

were soiled by identity theft. 

There are quality ―Mom and Pop‖ 

stores online. And there are 

thieves, just as in the real world. If 

you have questions, check with 

someone more experienced than 

you before placing your credit card 

or bank card information with a 

company online. There are multi-

ple, wonderful companies. There 

are some frauds. 

 

Beware of emails that pretend to 

be from the FBI, PayPal, and Ama-

zon, Chase bank or other well-

known financial institutions claim-

ing that there may have been 

fraudulent activity on your account 

and telling you to click on a link 

provided in the email to verify your 

account information. DO NOT DO 

THIS! If you have questions regard-

ing your account, open a separate 

browser, type in the address your-

self, and then login and 

check on things. Be sure to for-

ward the email to the fraud divi-

sion of the company it claims to 

represent. That is the best way to 

track down these identity thieves. 

 

How much can people learn about 

you online? More than you think! 

Public information has always 

been available. You used to look 



Page 8 

When reading Dorothy’s fine 
article, think Sauk Computer 
User Group when she writes 
The Olympia Microcomputer 
Users Group and SCUG when 

she writes OMUG . 

 

Although there may be some 

situations where volunteering 

would not necessarily get you a 

longer, happier life (any veteran 

could fill you in on that), there are 

now studies showing that people 

who volunteer at least two hours 

a week do in fact receive health 

benefits from volunteering. 

 

According to an article by Adam 

Voiland at http://

health.usnews.com a 2007 report 

which drew on the results of 30 

studies said volunteering can in-

deed be good for your health. 

Voiland says the report indicates 

that ―people who volunteer enjoy 

longer lives, higher functional 

ability, and lower rates of depres-

sion and heart disease.‖ 

 

Volunteering keeps a person ac-

tive and interested, as well as 

helping stay connected with other 

people. 

 

Voiland quoted Steven Post, di-

rector of a research group at Case 

Western Reserve University that 

focuses on the ―scientific study of 

altruism, compassion, and ser-

vice,‖ as saying, ―The helping im-

pulse is very fundamental. When 

it is locked off we do not flourish.‖ 

 

If we look around, there are 

friends, neighbors, and family 

who could use a helping hand 

now and then. There are also non-

profit organizations whose mis-

U S E R  H E L P I N G  U S E R  

sion is to help people. You may be 

belong to one. In fact, if you’re read-

ing this newsletter, chances are you 

belong to The Olympia Microcom-

puter Users Group. 

 

Any group needs leadership, and 

OMUG is no exception. All our offi-

cers and key members are volun-

teers, and if you talk to any of them, 

my guess is that you’ll find they en-

joy taking an active part in our com-

puter users group, keeping it alive to 

fulfill its mission. 

 

OMUG’s purpose, according to our 

Bylaws, ―shall be to provide a non-

profit, educational, self-help organi-

zation for personal computer users; 

to cultivate cooperative relation-

ships among computer users in our 

community; and to promote knowl-

edgeable use of personal computer 

hardware and software.‖ 

 

Think about why you joined OMUG, 

and why you keep renewing your 

membership each year. Maybe you 

have computer expertise to offer 

and you enjoy helping others. Maybe 

you don’t know a lot about com-

puters and are looking for help. 

Whatever your reason, computer 

expertise, or lack of it, is irrelevant 

to participating in leadership of our 

group. People with many different 

lives, leisure and work experiences 

have served as OMUG officers. You 

can, too. 

 
By Sr. Dorothy Robinson, Editor, Olympia 

Microcomputer Users Group, WA 

December 2010 OMUG News 

www.olymug.org / newsletter (at) olymug.org 

 

This article has been obtained from APCUG 

with the author’s permission for publication 

by APCUG member groups; all other uses 

require the permission of the author. 

A Happier, Longer Life? Volunteer! 
By Sr. Dorothy Robinson  

Are you Secure? (cont.) 

By Constance Brown  

up addresses in telephone 

books. And you could go to the 

auditor’s office to look up infor-

mation about someone’s prop-

erty. You could look up ad-

dresses on maps. Now all that 

information is readily available 

through the online white pages 

and the auditor’s web sites. Of 

course there are many map 

services. A GPS can guide you 

precisely to the locations you 

program into the system. Try 

―Googling‖ your name and the 

city in which you live. You will 

find references to your com-

ments in the local paper, infor-

mation about you that is in-

cluded in online publications 

and anything else that is public. 

 

By Constance Brown, President, 

Canton/Alliance/Massillon User 

Group, Ohio 

January 2011 issue, The Memory 

Map 

www.camug.org 

president (at) camug.org 

This article has been obtained 

from APCUG with the author’s per-

mission for publication by APCUG 

member groups; all other uses 

require the permission of the au-

thor.  
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There are many ways that you can use Excel's tools to fill out various cells in a worksheet. One of the 

most common tools is to copy a cell (or cells) and then paste them into other cells. The only problem 

with this approach is that when you copy cells, you also copy the format of the original cells into the 

target cells. What if you just want to copy the values from the original cells, but retain the formatting 

already applied in the target cells? 

You probably already know that you can use the Paste Special option from the Home tab of the 

ribbon (Excel 2007 and 2010) or the Edit menu (older versions of Excel), and then choose the 

Values option to paste just the values. If the target cells are right next to the original cells, there is an 

even easier way to accomplish the same task. Simply follow these steps: 

1. Select the original cells whose values you want to copy. 

2. Right-click on the fill handle (at the bottom right-corner of the selection) and drag the 

selection to encompass the target cells. When you release the mouse button, a Context 

menu appears. 

3. Choose the Fill Values option. Excel fills the target cells with the values from the original 

cells; the formatting remains unchanged. 

 

One frustration common to many Excel users is dealing with the way Excel handles cutting and 

copying to the Clipboard. It is particularly frustrating that you can select a range and copy it by 

pressing Ctrl+C, and then the copy "disappears" if you take any other action besides pasting right 

away. It would be great if copying and cutting worked just like it does in other applications, where the 

information is maintained in the Clipboard until it is explicitly replaced by something else. 

Unfortunately, there is no way to do this in Excel. There is a bit of a work-around, however, that 

Microsoft added in Excel 2000. Beginning in this version they implemented the Clipboard toolbar, as 

is available in other Office applications. Display the toolbar, and the last couple of things you cut or 

copied are visible in a palette of Clipboard entries. 

If you need even more functionality, however, you may want to look into a Clipboard extender. This 

classification of program goes way beyond what the Clipboard can do, allowing you to save and 

name cuts and copies and to use those named items days, weeks, or months later--even after a 

reboot. There are many different Clipboard extenders available on the market.  

 
 

 
 
 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission.  

Thousands of free Microsoft Word tips can be found online at http://word.tips.net. 

 

C O P Y I N G  V A L U E S  

U S E R  H E L P I N G  U S E R  

http://excel.tips.net/Pages/T002534_Annoying_Excel_Cuts_and_Copies.html#
http://excel.tips.net/Pages/T002534_Annoying_Excel_Cuts_and_Copies.html#
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Notice 

     The next meeting of  the  Sauk                                     

Computer  User Group will be  

May 14, 2011       

    Question & Answer: 1:00 PM                    

Business: 2:10 P.M.          

Program: 2:45 P.M. 

  Place: Whiteside Senior Center                                

 1207 West 9th Street                               

 Sterling, Illinois 61081 

B E T T Y  B E A T T Y  O U R  O W N  V P  W I L L  B E  D O I N G  T H E  P R O G R A M  

O N  T W I T T E R .   

Sauk Computer User Group                               

User Helping User                                             

2803 Spencer Dr.                      

Sterling, IL 61081 

There will be a Question & Answer    

Session starting at  1PM. 

Bring any questions you have about 

your computer or problems you may 

be having. It will be conducted by: 

     Neal Shipley & Art Bendick 


